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Release Notes 

 
 
This booklet provides an overview of the new features and 
capabilities that are incorporated into Winworks AutoShop Version 
7.  Since our last major release, Version 5.5, we have made over 
500 changes to Winworks AutoShop including suggestions from 
you, various enhancements and adjustments.  Each year we find 
that some worthy suggestions must be postponed for a future 
version as we prioritize those improvements that will have the 
largest benefit upon our thousands of users.  This new version 
can have a substantial impact on how the Winworks AutoShop 
software system contributes to your shop’s success.  To fully 
benefit from the substantial improvements, we highly recommend 
that you read this document thoroughly. 
 
 

  New Look and Feel      Track Marketing Source by WO  
Summary of New Features  

Text Messaging       Attach PDFs to Vehicle Record 
  PDF Integration   Easier Multi Window Navigation 
New Scheduler List View Advanced Search Capabilities 
42,000 Localities Database Optional Premium Parts Catalogs 

  Up to 35 Sales Tax Rates (Activant, NAPA and IAP) 
Up to 8 Estimating Options Import Jobs from Closed WOs 

  New Searchable Help System Batch Work Order Printing 
  Standard Task Appointments New Sublet Report by Vendor 
  USB Cash Drawer Integration And much more … 
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1. New Look and Feel – We have given Winworks AutoShop 
a brand new look and feel 
for Version 7.  The menu 
buttons no longer have 
titles below them.  Instead, 
you can view a tool tip for 
any button by hovering 
your mouse pointer over it.  
We’ve also enhanced the 
look and feel when 
AutoShop is maximized on 
wide screen monitors. 

 
2. Integrated Text Messaging – (Pro/Premium Editions, GS 
w/Pak) We’ve added a 
new and easy way to 
communicate to your 
customers via text 
messaging.  When you 
send a text message, you are sending a short message directly to 
your customer’s cell phone.  Responses from them are sent to 
your email address.  You can send text messages directly from 
the Lookup window, the Scheduler’s list view and the Marketing 
Machine.  When you click the Txt Msg button in the Lookup 
Window or Scheduler List View, you will see a menu of saved 
messages.  You can add or edit this list from the Standard Txt 
Msgs listing (select from the Lists menu).  The Scheduler List 
View adds an ‘Appointment Reminder’ message that automatically 
inserts appointment data into the message for you.  If text 
messaging has not been setup for a customer, you can set it up 
on the fly before sending your first message.   
 
Setting up Customers for Text Messaging 
To use the Text Messaging feature, you first need to have the 
Email system configured. Next, locate a customer via the 
Customer window and click the Setup TXT Messaging button.  On 
the setup screen, enter the customer’s first name, their 10 digit 
cell phone number and select their cell phone carrier.  To comply 
with carrier requirements, your customer must ‘Opt-In’ to receive 
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text messages from your shop.  To accomplish that, click on the 
‘Send Welcome Text MSG’ button.  A special text message will be 

sent to their phone asking them to respond with the last four digits 
of their phone number to enable messaging from you.  The 
Winworks Server handles this process for you as long as you 
maintain current technical support.  The Winworks Server will 
send a message to your system when the customers text 
messaging has been activated via the Winworks Mail Client 
program.  You can view the cell phones setup for your customer 
and their status on the View/Edit Cell Phone Contacts tab. 
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3.  PDF Integration – There is a new View/Create PDF option for 
the Accounting Reports and Work Order printouts.  This gives you 
a convenient way to preview a work order whether you’ve selected 
a standard or custom print format with options to save it to a PDF 
file or attach it to an email.  Now the work orders customers 
receive via email will look the same as the printed versions.  
AutoShop will also insert their email address when you email them 
a work order.  To view PDFs, you will need to download Adobe’s 
Acrobat Reader from the Adobe website. 
 
4.  Scheduler List View –  You can now view the days scheduled 

jobs and appointments in a 
convenient list format.  The list 

will show the time period, assigned technician, customer, vehicle, 
work order number and job description.  When you click on a job, 
you can view the jobs detailed description (1024 resolution only) 
and customer and vehicle contact information.  You can also send 
the customer a text message, email or view the work order itself or 
edit the appointment from the List View.  You can click on the 
column headers to change the sorting of the list.  You can also 
limit the list to a particular technician and use the Printer icon to 
print the selected technician’s jobs for the day.  When viewing the 
Day View, double-click a scheduled appointment or task to view 
that item in the schedulers List View. 
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5. New Help System - We have completely re-written the 
Winworks Help System and provided you a new powerful tool to 
learn about all the time saving features within your Winworks 
AutoShop system.  Often there are features you’re unaware of 

that can save you time and improve the way your shop is 
managed.  Now you can search the 
updated help system easily, create 
bookmarks for sections you want to refer to 
later and learn about features at your own 
pace.  If while you’re browsing the new Help 
system, you find a section you would like to bookmark, simply 
click the Bookmark button, click Add New Bookmark and it will be 
saved for you.  To ensure fast networking, the new Winworks Help 
System is installed locally on each computer and saved 
bookmarks are only saved for the computer they were 
created on.  You can also configure the top tool bar to 
include the Help button to more easily access the help system. 
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6. New Localities System –  We now include a database of over 
42,000 localities which are city/state/zip code combinations.  By 
default, the list is limited to your home state.  You can add 
additional status or use the entire US database. You can also 
customize the database by adding your own 
localities.  From the Lists menu, choose 
Localities.  To view or change the State selection 

click the Database Information 
button.  If you prefer to use the 
previous localities system, select 
the Data/Techlink Options tab on 
the Preferences window and 
select the ‘Use Legacy Localities 
system’ option. 

 
7. Multiple Sales Tax Rates -  We’ve expanded the number of 

special Sales Tax Rates you 
can setup.  Now, you can add 
up to 35 sales tax rates.  
Select Sales Tax Rates from 
the Lists menu.  As before, 
customers 
can be 

setup on any sales tax rate.  We have also 
modified the Sales Tax Report so that you can 

limit the report to only 
those customers setup 
on a particular sales tax 
rate.  For example, if 
you add a special 
Government sales tax 
rate, then you can print 
the Sales Tax Report 
for only those 

‘Government’ 
customers.  These 
combinations of 

features should allow you to get more precise sales tax 
information for your tax return. 
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8.  More Import Buttons on the Task Window – You can now 
have up to nine import buttons on the task window (7 on the 800 

resolution).  This was necessary as we add more and more 
importing options to the Winworks AutoShop system such as 
importing tasks from closed work orders as discussed in item 11 
below. 
 
9.  Advanced Lookup Search – The Lookup window now gives 
you a powerful way to locate a closed work order, counter sale or 
an estimate.  You can search your database based on customer 
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type, within a date range or dollar amount.  Other search options 
include: Service Advisor, the work order Reference field, key 
words in the task or part descriptions.  You can limit the search to 
specific technicians or parts or vehicles.  Once your search is 
complete, a list of all matching work 
orders or counter sale tickets will be 
shown.  Using the Work Order Report feature (see item 17 below), 
you can get parts and labor totals for those results.  To start an 
Advanced Search, from the Lookup window, click the Advanced 
Search option. 
  
10.  New Parts Catalog Interfaces – (Premium Edition Only)  
We have added 3 parts catalog 
interfaces to our new Premium 
Edition.  You can now locate 
and order aftermarket parts 
using Activant, IAP (Internet Auto Parts accessing multiple 
suppliers such as O’Reilly, Carquest, etc) and NAPA Online from 
within the Winworks AutoShop system.  Contact us for more 
information about upgrading to our Premium Edition. 
 
11. Import Tasks from Closed Work Orders – We’ve added a 
new import option on the Task window.  You can now import a 

task from a recent closed 
work order for the current 
vehicle onto the new work 
order.  This allows you to 
easily ‘repeat’ a previous 
job without re-creating the 
task.  Add this ‘Import 
Option’ by selecting it as 

one of your estimating systems in the Interface Settings window.  
By default, the part prices used will be those from the previous 
work order.  However, you can choose to have AutoShop update 
the pricing to reflect the 
current price for parts 
imported.  This option is at the bottom of the Interface Settings 
window. 
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12. Standard Task Appointments – You can now create an 
appointment using one of your Standard Tasks.  That way, when 
you convert the appointment to a work order, the standard task 
will already be setup.  We’ve included our yellow ‘Power Search’ 
to help you quickly find the standard task you’re looking for.  As 
always, drag an appointment from the schedule to the Write WO 
icon below the Make Appointment button to convert the 
appointment to a new work order. 

 
13. Open Window Indicator – Since Winworks AutoShop allows 
you to have multiple work orders open at the same time along with 
other windows, we’ve made it easier for you to see a list of all 

open work 
orders by moving 
your mouse to 

the bottom information panel.  There, you’ll now see a button for 
each open window when more than one window is open.  Click on 
a button to open that window.  The same list has been available in 
the Window menu. We do suggest, however, that you close work 
order windows by clicking OK since that is when your changes are 
saved. 
 
14. Attach PDF Documents to a Vehicle Record – You can now 
attach a PDF document to the vehicles record by clicking the 
Pictures/PDFs tab on the vehicle window and clicking the Add 
Picture/PDF button.  
From the list, you 
can view or print 
any picture or PDF 
you’ve attached to a 
vehicle record. 
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15. Track Marketing Source on each Work Order – In addition 
to tracking the marketing source of new customers on the 
customer window, you can now track the marketing source for 
each work order.  We’ve also expanded the number of marketing 
sources so that you can track individual advertizing promotions 
among other sources.  To view or add new marketing sources, 
select Marketing Sources from the Lists menu.  To specify a work 
order marketing source, choose a pre-defined marketing source 
on the Source drop down list.  The Management Overview report 
will provide results of your marketing efforts using the source you 
selected on work orders. 
 
16.  Work Order Customer Selection – When you search for a 

customer in the work order 
window, similar customers are 
shown in the drop down list.  
You can now point to a 
customer in the drop down list 
with your mouse to view a list 
of their vehicles before you 
select the customer. 

 
17. Work Order Report – The new Work Order Report will print 
the list all the work orders displayed showing their date, work 
order number, customer, vehicle, labor, parts and total.  This 
report is available from the Lookup window, along with the 

Customer and Vehicle 
windows. On the Lookup 
window, click the Print Menu button and 
select Work Order Report.  On the 
Customer and Vehicle windows, click the 

Reports Menu button, and click Work Order Report.    
 
18. Batch Work Order Printing – You can now print multiple 
work orders at a time from the Lookup window and the Customer 
and Vehicle windows.  From the Lookup window, click the Print 
Menu button and choose Select Items to Print.  On the Customer 
and Vehicle windows, click the Print button and choose Select 
Items to Print. 
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19. Markup Imported Labor Hours  – You can now automatically 
increase imported labor hours when importing from labor 
estimating systems.  This option at the bottom of the Interface 
Settings window allows you to set a percentage to increase those 
hours automatically. (i.e. enter 10 to increase labor hours by 10%) 
 
20. Purchase Order System Enhancements –You can now 
press ENTER on the Purchase Order List window to open/view 
the selected PO.  You can now receive a PO from the PO Listing 
window.  In the Receive Parts window, the totals are now updated 
after receiving a PO.  When editing a PO, when you click Add 
Part, it will only search for parts related to that vendor.  If you 
selected your company as the supplier, previously clicking on that 
PO would show Unknown vendor for each part and allow 
reselection of a vendor.  That has been corrected.   When adding 
individual parts to a part order, the search engine was 
inadvertently turned off after the first part was added.  This has 
been corrected.  Previously when using the Inv List option on the 
Order Part window, you would only be viewing parts where the  
stock level was less than the minimum level.  Now, this version 
will ask: "Do you want to only view parts whose Stock Level is 
LESS than the Minimum Level selected for the part?" and if you 
choose NO, you will view ALL parts for the selected vendor. 
 
21. Lookup Window Enhancements – We’ve corrected issues 
related to the automatic refreshing of items in the Lookup window 
listing.  We’ve added a new time period selection to enable 

viewing of all work order history.  We’ve added a 
Complete button so that you can easily mark a work 

order as complete in the Lookup window without opening the work 
order. 
 
22. New Sublet Payable Report by Vendor – This new report 
shows your vendors sublet charges by vendor for a time period.  
The report shows the date, sublet task description, work order 
number, payable (cost) amount and the vendors name along with 
a total for each vendor.  Select Sublet Payable Report from the 
Accounting menu/Accounting Reports menu. 
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23. New USB Cash Drawer Integration – We’ve added 
integration with APG Series 4000 USB Cash Drawers.  You can 

now add a mechanical cash drawer on any 
computer with a USB port.  If you receive a cash 
payment the drawer will open automatically.  
Also, if you have full security rights, you can 

open the drawer by pressing Control-Z (or Open Cash Drawer 
from the Options menu).  To enable the APG USB Cash Drawer, 
select it on the Other Settings tab of the Preferences window. 
 
24. Show Standard Tasks within Groups – You can now 
organize your Standard Tasks into Groups.  If the Inv Group 
option is selected, the list of Standard Tasks in both the Task 
window and the Standard Task window show the main Inventory 
Groups first.  Double-click a group to see the Standard Tasks 
assigned to that group.  This can aid in navigating to the standard 
task you’re looking for.  To turn this option on, from the 
Preferences window (select Preferences from the Options menu), 
choose the Work Order Settings tab and select the Show Std Task 
Listing within Inv Groups option. 
  
25. New Customer Parts History Report  – Similar to the Parts 
History report available from the Vehicle window, you can obtain a 
list of all parts sold to a customer by clicking the Reports Menu 
button on the customer window and selecting Parts History 
Report.  
 
26. Easy Customer Address Label – You can print a single 
customer address from 
the Customer window 
directly onto any label 
position on an Avery 
5160 label sheet.  Locate a customer on the Customer window, 
click the Print Address Label button, select one of the 30 label 
positions for a partially used Avery 5160 label sheet and click 
Print.  If the customers address is not centered on the label, use 
the Adjustment button to change the left and top adjustments 
which are in inches. 
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27. New Inventory Purchases Report by Department option – 
You can now show the inventory purchases report for a selected 
department. 
 
28. XCharge Credit Card Processing Enhancements – We’ve 
made many improvements to our integrated XCharge credit card 
processing system including the ability to accept ATM payments.  
In many cases, customers have chosen to XCharge as their credit 
card processing provider and lowered their rates and increased 
work order writing efficiency by processing directly within 
Winworks AutoShop. 
 
29. Search Phone Numbers – You can now locate a customer by 
searching for their phone number even if it isn’t their main number.  

On the Customer window, click the Phones button 
and enter the phone number to search. 

 
30. More Info on Management Overview – Management 
Overview now includes totals for the number of services 
performed and the dollar amount. 
 
31. New Employee Window Report – You can now view a report 
showing all the technicians assigned jobs, estimated hours, etc. 
by clicking the Report button on the Employee window. 
  
32. CARFAX Integration – We’ve improved the reliability of our 
CARFAX uploader.  If you’re not currently integrating with 
CARFAX, consider the advantages: 1. Your customer gets ‘credit’ 
for maintaining their vehicle since their services will show on the 
CARFAX report enhancing their vehicles resale value., 2. The 
CARFAX report will show you as the Repair facility where they 
have serviced their car, giving you a chance to continue to 
maintain the vehicle after it changes hands, and 3. You can obtain 
valuable vehicle information using the CARFAX VIN Decoder. 
 
33 You can view a list of all users in a multi user environment by 
clicking User List from the Users menu. 
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34. You can specify a default payment method on the Other 
Settings tab of the Preferences window (select Preferences from 
the Options menu) 
 
35. We’ve replaced our previous Mitchell VME interface with two 
new Mitchell Interfaces: DVD and Online. 
 
36. We’ve redesigned the timesheet window in TechLink so you 
can view a Active Tech list showing which technicians are working 
and what job they’re logged into.  To view this option on the 
timesheet window, select the ‘Show Active Tech List’ option in the 
Data/TechLink tab of the Preferences window. 
  
37. We’ve made several improvements to the Marketing Machine.  
In addition to its new look and feel and the new Text Messaging 
option (see item 2 above), we now can export email address to 
data files.  If you select multiple zip codes for location based 
marketing, your list is remembered the next time you run the 
Marketing Machine.  Also when adding a location, you can enter a 
city name instead and all the zip codes for that city will be entered. 
 
38. Miscellaneous Changes: You can now change the Part 
Condition Status Indicator (N-New, R-Rebuilt, S-Special Order, U-
Used) when you edit a part on a work order.  The Inventory List 
window now has a Receive button to receive parts on the fly from 
that window.  You can now add an email address for a vendor.  
On the Standard Task window, you can limit the list to certain 
vehicles only.  The Payments report now includes a subtotal of all 
payments before A/R Charges.  The Labor reports have been 
enhanced.  You can now print from the Receive Parts window. 
You can add a jpg picture to any inventory part.   You can now 
select a printer when printing a Custom configured work order.  
Custom work orders can now be in color and include a logo.  You 
can turn off the question “Add Another Part?” in the Add Part 
window on the Data/TechLink options tab of the Preferences 
window. The Timesheet window in TechLink now has a ‘Show All 
Employees’ option for those with Shop Foreman authority.  The 
Wrenchead interface can now use part pricing from your internal 
database when importing parts onto a work order.  We’ve added 
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an option to allow you to print the customer and vehicle boxes on 
each page of the standard work order using the /PC command line 
switch.   The Order Parts window now includes a running total for 
both quantity and cost.  New statement files have been added for 
California shops to comply with BAR requirements (See 
designat.smt and tirepres.smt).  We have made many 
improvements to the Payment Allocation system.  You can now 
require that all parts sold be added to the database on the 
Pricing/Other tab of the Inventory Settings window.   
 
 
 
Program Optimization

 

: If you are running Winworks AutoShop on 
a network and would like to increase performance, please review 
the document Network Performance.doc in the Misc folder on the 
Ver. 7 CD.  It contains the latest information we have regarding 
improving network performance including the use of Microsoft 
Terminal Services which we strongly recommend for three user 
and larger networks. 

Tech Support Fee Increase

 

:  Beginning July 1, 2011 all technical 
support tier fees will increase by $50 per year.  This modest 
increase is the first increase in over 3 years.  We review other 
software provider support fees and find that we are still among the 
lowest priced support services available.   

 
 
In total we’ve made over 500 changes and more major 
improvements than any previous version.  Thank you for your 
suggestions!  It is our partnership with you that has made  
Winworks AutoShop one of the most popular automotive 
management systems available today!  We hope you’ll enjoy 
the new features and enhancements. 
  
 

The Winworks Team: Kevin, George, Brian, Julie, 
Jason, Edward, Kathee and Jenny. 
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Installation Instructions 
 
 

1.  Place the Winworks Version 7 CD in your CD drive. 
 

2.  Double-click the My Computer icon on your desktop, click 
the Winworks CD icon with the right mouse button and select  
Open/Explore.  Double-click the Setup.exe icon. 
 

This upgrade must be installed on all networked computers.  

 

Most 
do not require an Upgrade Key number.  However, if you need the 
number, call us during our regular business hours. 

 
 
 

Winworks Software 
® 

344 Placerville Dr. #5 
Placerville, CA  95667 
 
 
Phone: 1-800-946-9675   (1-800-WINWORKS) 
Fax:  1-530-621-3465 
Website: www.winworks.com 
Email:  support@winworks.com 
Forum:   Visit http://groups.yahoo.com (search for Winworks) 

 
 Like us on Facebook – Search for Winworks 
 
  

Follow us on Twitter – Search for WinworksUSA 

http://www.winworks.com/�
mailto:support@winworks.com�
http://groups.yahoo.com/�
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